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Section 2  Offline Operations
2-1 Preparations for Programming

2-1-1 Opening a new file
To create a new program, start the personal computer loader and open a new file (program window) by the following operations.

◊ Select the [New] command from the [File] menu. The {Select PC Model} dialog box is displayed.

* The models displayed in the above dialog box depend on the version of the loader software.

◊ After selecting the appropriate PC model, left-click the [OK] button.
A program window is displayed in the main window of the loader.

The programming instructions that can be used
and the contents of the system definition are
determined by the PC model selected here.

This is the program window. You can
start writing a program in this window.
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2-1-2 Menus and tool bars used to edit program
The commands in the menus and the tool bars (buttons) that are mainly used when editing a program are explained below. All
the functions of the tool bars are included in the menus.
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2-1-3 Setting tag entry/display
During program editing, it is possible to enter tags while writing instructions in the program. It is also possible to display the tag
entries on the program. The methods of setting tag entry/display are explained below.

The tag is a label (name) which is in one-to-one correspondence with an address. It corresponds to a comment in the

MS-DOS-based loader.

(1) Setting program editor
◊ Select the [Environment...] command from the [Option] menu.

The {Environment Options} dialog box is displayed.
◊ Left-click the [Display] or [Editor tab].

The items to set to edit and display the program are displayed.

[Display] tab [Editor] tab

1) Setting display option

[Both Tag and Address] option button
Displays an address and a tag above the instruction symbol.

[Tag] option button
Displays only a tag above the instruction symbol. (Note, however, that when no tag has been set for the instruction address, the
instruction address is displayed.)

[Address only] option button
Displays only an address above the instruction symbol.

2-1 Preparations for Programming
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2) Setting automatic tag entry
When the [Auto Document] box is checked, the {Untitled 1 Offline} dialog box shown below is displayed during program editing.

Note 1: In a tag name, the comma (,) cannot be used.
2: In a description, the comma (,) cannot be used. If a comma is included in the description, it is automatically deleted

when the description is added to the data base. Note that the description is not displayed on a ladder program.

2-1 Preparations for Programming

Displayed when the [OK] button is left-
clicked after an address is entered.

The tag name must not exceed 24
characters in length.  Note 1)

The description must not exceed
50 characters in length.  Note 2)
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<Tag Editor>
There are two methods of entering a tag name. One is using the {Untitled 1 Offline} dialog box described above, and the other
is using [Tag Editor].

For the method of using [Tag Editor], refer to “2-5 Tag Edit.”

2-1 Preparations for Programming
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2-2-1 Writing contacts and outputs
Here, the method of preparing a line which combines contacts and outputs as shown below is explained.

(1) Writing a series line
The method of writing a series line shown below is explained.

1) Writing contacts
◊ Left-click the [Common] or [Contact] tab of the [Instruction group] tab on the ladder edit tool bar.
◊ Left-click the [Normally Open Contact] button.
◊ Move the cursor to the position in which to describe an instruction and left-click that position.

The {Address Entry} dialog box is displayed.

◊ Enter the address of the contact in the [Address] text box.
In this example, <B0> is entered.

◊ Left-click the [OK] button.
When in the {Environment Options} dialog box the [Auto Document] box has been checked, the {Untitled 1 Offline}
dialog box as shown in the following diagram is displayed. When the [Auto Document] box has been unchecked, the
{Untitled 1 Offline} dialog box is not displayed and the contact is described in the program window.

2-2 Programming

Move the cursor to this
position and left-click it.
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◊ Enter a tag name in the [Tag] text box as required.
In this example, <Start Switch> is entered.

◊ Enter a description in the [Description] text box as required.
In this example, <Pushbutton Switch Blue> is entered.

◊ Left-click the [OK] button.
The normally open contact, address, and tag are displayed as illustrated below.

2) Writing series contacts
◊ Left-click the [Common] or [Contact] tab of the [Instruction group] tab on the ladder edit tool bar.
◊ Left-click the [Normally Closed Contact] button.
◊ Move the cursor to the position in which to describe an instruction and left-click that position.

The {Address Entry} dialog box is displayed.

2-2 Programming

Normally open contact, address,
and tag are displayed here.
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◊ Enter the address of the contact in the [Address] text box.
In this example, <B1> is entered.

◊ Left-click the [OK] button.
As shown below, the normally closed contact is connected in series to the normally open contact. Note that when in the
{Environment Options} dialog box the [Auto Document] box has been checked, the {Untitled 1 Offline} dialog box is
displayed. The explanation about this shall be omitted here.

◊ In the same way as described above, write normally open contacts “B0002” and “B0003” and normally closed contact
“B0004” as shown in the following diagram.

2-2 Programming

Move the cursor to this
position and left-click it.
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3)  Writing outputs
◊ Left-click the [Common] or [Contact] tab of the [Instruction group] tab on the ladder edit tool bar.
◊ Left-click the [Output] button.
◊ Left-click the right-hand part of the node in the position in which to describe an instruction.

The {Address Entry} dialog box is displayed.

◊ Enter the address of the output in the [Address] text box.
In this example, <B20> is entered.

◊ Left-click the [OK] button.
As shown below, the output is connected in series to the normally closed contact.

2-2 Programming

Move the cursor to this
position and left-click it.
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(2) Writing branches
Here, the method of writing a branch of a line shown below is explained.

1) Writing branch to single contact
◊ Left-click the [Common] or [Branch] tab of the [Instruction group] tab on the ladder edit tool bar.
◊ Left-click the [Branch with NO] button.
◊ Move the cursor to the contact (B0000) in the position in which to describe an instruction, and left-click that position. (In

this case, a green instruction selection frame is displayed.)
The {Address Entry} dialog box is displayed.

◊ Enter the address of the branch in the [Address] text box.
In this example, <B5> is entered.

◊ Left-click the [OK] button.
As shown below, the normally open contact is connected in parallel with the contact.

2-2 Programming

Branch to single contact Branch to multiple contacts

Move the cursor to this
position and left-click it.
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2) Writing branch to multiple contacts

<Description of pass>
◊ Left-click the [Branch] tab of the [Instruction group] tab on the ladder edit tool bar.
◊ Left-click the [Pass Below] button.
◊ Move the cursor to the contact (B0002) above the position in which to describe a branch, and left-click that position. (In

this case, a green instruction selection frame is displayed.)
As shown in the following diagram, a “pass” is displayed.

◊ In the same way as described above, describe “passes” below contact (B0003) as shown below.

2-2 Programming
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<Description of branch down>
◊ Left-click the [Branch Down] button.
◊ Left-click a selected contact (B0001) in this example.

A branch is described downward from the right end of the selected contact.

◊ In the same way as described above, describe a branch down from the right end of another contact (B0003) in this
example.

2-2 Programming
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<Changing pass to contact>
◊ Left-click the [Common] or [Contact] tab of the [Instruction group] tab on the ladder edit tool bar.
◊ Left-click the [Normally Open Contact] button.
◊ Move the cursor to the pass that is to be changed to a contact, and left-click the pass.

The {Address Entry} dialog box is displayed.

◊ Enter the address of the contact in the [Address] text box.
In this example, <B6> is entered.

◊ Left-click the [OK] button.
As shown in the following diagram, the pass is changed to a normally open contact.

2-2 Programming
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(3) Writing branch outputs
Here, the method of writing a branch output shown below is explained.

◊ Left-click the [Common] or [Output] tab of the [Instruction group] tab on the ladder edit tool bar.
◊ Left-click the [Output] button.
◊ Move the cursor to the node at the position in which to describe an instruction, and left-click that node.

The {Address Entry} dialog box is displayed.

◊ Enter the address of the output in the [Address] text box.
In this example, <B21> is entered.

◊ Left-click the [OK] button.
The branch output is connected as shown below.

2-2 Programming

Move the cursor to this
position and left-click it.



2-15

<Writing contact “B0008”>
◊ Left-click the [Common] or [Contact] tab of the [Instruction group] tab on the ladder edit tool bar.
◊ Left-click the [Normally Open Contact] button.
◊ Move the cursor to the node at the position in which to describe an instruction, and left-click that node.

The {Address Entry} dialog box is displayed.

◊ Enter the address of the contact in the [Address] text box.
In this example, <B8> is entered.

◊ Left-click the [OK] button.
As shown below, the contact is connected to the left side of output “B0021.”

2-2 Programming

Move the cursor to this
position and left-click it.
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(4) Writing branch skip lines
The method of writing a branch skip line is explained below.

◊ Left-click the [Banch] tab of the [Instruction group] tab on the ladder edit tool bar.
◊ Left-click the [Pass Below] button.
◊ Move the cursor to the contact (B0005) above the position in which to describe a branch contact, and left-click the

contact.
◊ A “pass” is displayed as shown in the following diagram.

◊ In the same way as described above, describe the “pass” to the position below contact (B0006).

2-2 Programming

The method of writing this
line is explained.
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1) Writing branch skip
◊ Left-click the [Branch Skip] button.
◊ Move the cursor to contact (B0006) and left-click the contact.
◊ A “branch skip line” is described at the right end of the selected contact (B0006) as shown in the following diagram.

2) Writing branch down
◊ Left-click the [Branch Down] button.
◊ Move the cursor to contact (B0002) and left-click the contact.
◊ A branch down is described from the right end of the selected contact (B0002) and connected to the branch skip as

shown in the following diagram.

2-2 Programming
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3) Changing pass to contact
◊ Left-click the [Common] or [Contact] tab of the [Instruction group] tab on the ladder edit tool bar.
◊ Left-click the [Normally Open Contact] button.
◊ Move the cursor to the pass that is to be changed to a contact, and left-click that pass.

The {Address Entry} dialog box is displayed.

◊ Enter the address of the contact in the [Address] text box.
In this example, <B7> is entered.

◊ Left-click the [OK] button.
The pass is changed to a contact.

2-2 Programming
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2-2-2 Writing a returning
The method of describing a “Returning” instruction is explained below.

(1) Writing returning (output)
First, the method of writing a returning (output) is explained.

◊ Left-click the [Contact] tab of the [Instruction group] tab on the ladder edit tool bar.
◊ Left-click the [Returning (Output)] button.
◊ Move the cursor to the right of the node in which to describe an instruction, and left-click that node.

The {Address Entry} dialog box is displayed.

◊ Enter a returning destination number in the [Address] text box.
In this example, <1> is entered.

◊ Left-click the [OK] button.
A returning (output) is described in the program window.

2-2 Programming

Move the cursor to this
position and left-click it.

Enter only a number.
Specify a returning
destination in the range
0 to 23.
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(2) Writing returning (input)
Next, the method of describing a returning (input) is explained.

1) Preparing line block starting point
Since a returning (output) and a returning (input) cannot be prepared in the same line block, it is necessary first to insert a line
block starting point for preparing a new line.

◊ Left-click the line (symbol) above the position in which to insert a line block starting point.
◊ Left-click the [Insert Line] button on the ladder edit tool bar.

A line block starting point is inserted.

2) Writing returning (input)
◊ Left-click the [Contact] tab of the [Instruction group] tab on the ladder edit tool bar.
◊ Left-click the [Returning (Input)] button.
◊ Move the cursor to the node in which to describe an instruction, and left-click that node.

The {Address Entry} dialog box is displayed.

◊ Enter a returning (input) destination number in the [Address] test box.
In this example, <1> is entered.

◊ Left-click the [OK] button.
A returning (input) is described in the program window.

2-2 Programming

Move the cursor to this
position and left-click it.

Enter only a number.
Specify a returning
(input) destination
number in the range
0 to 23.

Line block starting point that
has been newly inserted
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2-2-3 Writing Inverse instruction
The method of describing an “Inverse” instruction is explained below.

◊ Left-click the [Contact] tab of the [Instruction group] tab on the ladder edit tool bar.
◊ Left-click the [Invert] button.
◊ Move the cursor to the node in which to describe an instruction, and left-click that node.

An “Inverse” instruction is described in the program window.

◊ Write in the output to complete the line.

2-2 Programming

Returning (input) instruction
that has been prepared For the method of preparing

this, refer to “2-2-1.”

For the method of describing
a contact, refer to “2-2-1.”

“Inverse” instruction that
has been prepared

For the method of describing
an output, refer to “2-2-1.”
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2-2-4 Writing ON-delay timer
The method of describing an “ON-delay timer” is explained below.

◊ Left-click the [Tmr/Counter] tab of the [Instruction group] tab on the ladder edit tool bar.
◊ Left-click the [ON-Delay Timer] button.
◊ Move the cursor to the node in which to describe an instruction, and left-click that node.

The {Address Entry} dialog box is displayed.

◊ Enter a timer address in the [Address 1] text box. The timer identifier “T” has been described automatically.
In this example, <1> is entered.

◊ Enter a timer setting time in the [Address 2] text box.
In this example, <300> is entered (the timer starts three seconds later).

◊ Left-click the [OK] button.
An “ON-delay timer” is described in the program window.

2-2 Programming

Enter a timer address.

 Enter a timer setting time.
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◊ Write in a timer output contact and an output line to complete the line block.

2-2-5 Writing Up counter
The method of describing an “Up counter” is explained below.

◊ Prepare a normally open contact (address: B0001) beforehand.
◊ Left-click the [Tmr/Ctr] tab of the [Instruction group] tab on the ladder edit tool bar.
◊ Left-click the [Up Counter] button.
◊ Move the cursor to the node in which to describe an instruction, and left-click that node.

The {Address Entry} dialog box is displayed.

◊ Enter a counter address in the [Address 1] text box. The counter identifier “C” has been described automatically.
In this example, <1> is entered.

2-2 Programming

Prepare a line separate from
the timer line, above.

For the method of describing
a contact and an output, refer
to 2-2-1.

Enter a counter address.

Enter a counter setting time.
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◊ Enter a counter setting time in the [Address 2] text box.
In this example, <50> is entered.

◊ Left-click the [OK] button.
An “Up counter” is described in the program window.

◊ Left-click the [Common] or [Contact] tab of the [Instruction group] tab on the ladder edit tool bar.
◊ Left-click the [Normally Open Contact] button.
◊ Move the cursor to the node in which to describe an instruction, and left-click that node.

The {Address Entry} dialog box is displayed.

◊ Enter the address of the contact in the [Address] text box.
In this example, <B10> is entered.

◊ Left-click the [OK] button.
A contact is inserted as shown below.

2-2 Programming

Next, add a contact for
resetting the current value
of the counter.
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◊ Write in a counter output contact and an output line to complete the line block.

2-2 Programming
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2-2-6 Writing a shift register
The method of describing a “shift register” (SR) is explained below.

◊ Prepare a differentiation line (pulse line) which provides a clock signal for the shift register.
◊ Describe a contact which provides an input signal for the shift register. (Use a line different from the differentiation line.)

Prepare a line shown in the following diagram beforehand.

<Writing shift register instruction>
◊ Left-click the [Output] tab of the [Instruction group] tab on the ladder edit tool bar.
◊ Left-click the [Shift register] button.
◊ Move the cursor to the node in which to describe an instruction, and left-click the node.

The {Address Entry} dialog box is displayed.

2-2 Programming

Enter the number of shift bits.

Enter the shift starting point.
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◊ Enter the number of shift bits in the [SR Length] text box.
In this example, <23> is entered.

◊ Enter a memory address from which to start the shift in the [SR Address] text box.
In this example, <M5> is entered (shift from M0005 to M001B).

◊ Left-click the [OK] button.
A “shift register” instruction is described in the program window.

2-2 Programming

Describe contacts which provide necessary
conditions. For the method of describing
contacts, refer to “2-2-1.”
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2-2-7 Writing Data Transfer (MOV) instruction
The method of describing a “Data Transfer” (MOV) instruction is explained below.

◊ Left-click the [Transfer] tab of the [Instruction group] tab on the ladder edit tool bar.
◊ Left-click the [MOV] button.
◊ Move the cursor to the node in which to describe the instruction, and left-click the node.

The {Address Entry} dialog box is displayed.

◊ Select either the optional [NO] or [NC] (contact) button.
◊ Enter the address of the contact that provides the condition for execution of the instruction in the [Condition Contact]

text box.
In this example, <B0> is entered.

Method of describing the condition for execution of instruction
• When the instruction is to be executed “unconditionally,” leave the [Condition Contact] text box blank.
• When a “Returning (input)” instruction is used as the condition for execution of the instruction, enter the returning
  (input) number in the [Condition Contact] text box.

◊ Enter the address from which to transfer data in the [Address 1] text box.
In this example, <WB5> is entered.

◊ Enter the address to which data is to be transferred in the [Address 2] text box. In this example, <WM10> is entered.
◊ Left-click the [OK] button.

A Data Transfer instruction (MOV) with a condition contact is described as shown in the following diagram.

2-2 Programming

Enter the address to which
data is to be transferred.

Move the cursor to this
position and left-click it. Enter the address of the contact that

provides the condition for execution.

Enter the address from which
data is to be transferred.
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2-2 Programming
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2-2-8 Writing Data Table Definition (TABL)
The method of describing “Data Table Definition” (TABL) instruction is explained below.

◊ Left-click the [Misc] tab of the [Instruction group] tab on the ladder edit tool bar.
◊ Left-click the [TABL] (Data Table Definition) button.
◊ Move the cursor to the node in which to describe the instruction, and left-click the node.

The {Address Entry} dialog box is displayed.

• Entry in Data (A)
Describe the data items of the DATA statement, each separated by a comma (,).
For data of SI or DI type, prefix an “h” to each data item.
For data of BD type, do not prefix an “h.”
For DI-type data, each data item entered must be a numerical value five digits or more in length. (For example, write
h00000, not h0.)

◊ Enter the appropriate data in each of the text boxes.

2-2 Programming
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◊ Left-click the [OK] button.
Data Table Definition (TABL), and Data (DATA) are described as shown in the following diagram.

Note:  With the data table definition (TABL), data end (DEND) is required at the end of the DATA statement.

2-2 Programming
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Here, the method of modifying or changing a program that has been prepared is explained.

2-3-1 Changing instructions/addresses
The method of changing an instruction (symbol) and an address in the following program is explained below.

◊ Left-click the [Common] or [Contact] tab of the [Instruction group] tab on the ladder edit tool bar. (To change an
instruction too, previously select the new instruction button by left-clicking it.)

◊ Left-click the [Normally Closed Contact] button.
◊ Move the cursor to the instruction (symbol) to be changed, and left-click the instruction.

The {Address Entry} dialog box is displayed.

◊ Change the address that is displayed in the [Address] text box (the address that has been entered).
In this example, <B10> is entered.

◊ Left-click the [OK] button.
The {Tag Edit} dialog box is displayed.
 Note, however, that the {Tag Edit} dialog box is not displayed when the [Auto Document] box has been checked in the
environment setting session.

2-3 Program Modification
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◊ Enter a tag name in the [Tag] text box.
In this example, <Motor Start Switch> is entered.

◊ Enter an explanatory statement in the [Description] text box as required.
◊ Left-click the [OK] button.

The contact and tag name are changed.

Tag
If once the tag name is defind(“B0000:Start Switch” in this sample), it is stored in a tag data base. For information on
changeing or deleting it.

refer to “2-5 tag Editor”.

2-3 Program Modification
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2-3-2 Addition of lines/instructions
Here, the method of adding a new line or instruction to an existing program is explained.

(1) Inserting a new line
The method of inserting a new line into a program is explained below.

◊ Left-click the [Selection tool] button on the ladder edit tool bar.
◊ Left-click the line (instruction symbol) above the position into which to insert the line block starting point.

◊ Left-click the [Insert Line] button on the ladder edit tool bar.
The line block starting point is inserted.

Position of [line insertion]
By using [Editor Options] of the [Environment Options] menu, it is possible to specify whether a line is to be inserted
before or after the line on which the cursor is positioned.

2-3 Program Modification
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◊ Write a contact and an output at the newly inserted “line block starting point” as shown in the following diagram.

(2) Inserting a new contact
The method of inserting a contact into a series line and the method of inserting a contact into a branch line are explained
below.

1) Inserting a contact into a series line

◊ Left-click the [Common] or [Contact] tab of the [Instruction group] tab on the ladder edit tool bar.
◊ Left-click the [Normally Open Contact] button.
◊ Move the cursor to the node into which to insert the instruction, and left-click the node.

The {Address Entry} dialog box is displayed.

2-3 Program Modification
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◊ Enter the address of the contact in the [Address] text box.
In this example, <B15> is entered.

◊ Left-click the [OK] button.
The contact is inserted in series between contacts as shown in the following diagram.

2) Inserting series contact into branch line

◊ Left-click the [Common] or [Contact] tab of the [Instruction group] tab on the ladder edit tool bar.
◊ Left-click the [Normally Open Contact] button.
◊ Move the cursor to the node into which to insert the instruction, and left-click the node.

The {Address Entry} dialog box is displayed.

2-3 Program Modification
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◊ Enter the address of the contact in the [Address] text box.
In this example, <B16> is entered.

◊ Left-click the [OK] button.
As shown below, the contact is inserted and the “branch down” shifts to the right.

3) Inserting branch contact into branch line

◊ Left-click the [Common] or [Contact] tab of the [Instruction group] tab on the ladder edit tool bar.
◊ Left-click the [Branch with NO] button.
◊ Move the cursor to the node into which to insert the instruction, and left-click the node.

The {Address Entry} dialog box is displayed.

2-3 Program Modification
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◊ Enter the address of the contact in the [Address] text box.
In this example, <B17> is entered.

◊ Left-click the [OK] button.
As shown below, the contact is inserted in parallel between the upper and lower contacts.

2-3 Program Modification
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(3) Editing connecting lines
Here, the method of inserting or deleting connecting lines between instruction symbols (vertical and horizontal lines) is
explained.

1) Deleting vertical connecting line
◊ Left-click the [Branch] tab of the [Instruction group] tab on the ladder edit tool bar.
◊ Left-click the [Branch Clear] button.
◊ Left-click the instruction symbol located at the top, left of the vertical connecting line to be deleted.

As shown in the following diagram, the vertical connecting line is deleted.

2-3 Program Modification
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◊ In the same way as described above, delete the remaining vertical connecting lines to prepare the line shown in the
following diagram.

2) Inserting a vertical connecting line
◊ Left-click the [Branch] tab of the [Instruction group] tab on the ladder edit tool bar.
◊ Left-click the [Branch Down] button.
◊ Left-click the instruction symbol (B15) located at the top, left of the position in which to describe a vertical connecting line.

As shown in the following diagram, the vertical connecting line is described from the right end of the selected instruction
symbol downward.

◊ In the same way as explained above, describe the remaining vertical connecting lines to prepare the line shown in the
following diagram.

2-3 Program Modification
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3) Writing horizontal connecting line (pass)
◊ Left-click the [Contact] tab of the [Instruction group] tab on the ladder edit tool bar.
◊ Left-click the [Pass] button.
◊ Left-click the blank part in which to describe a pass (horizontal connecting line).

As shown in the following diagram, a pass is described.

(4) Compressing a program (deleting blanks)
If a line can be compressed vertically (horizontally) after deleting unnecessary blanks during programming, it is compressed
upward (to the left). The method of compressing a program is explained below.

 

2-3 Program Modification



2-42

◊ Select [Compress Program] from the [Edit] menu and then select [Compress a line] or [Compress whole program].

• When [Compress a line] is selected, only the line at the current cursor position is compressed.
• When [Compress whole program] is selected, all the lines are compressed.

(5) Inserting a row (blank row)
This function is used to create a blank row in a line.
(The operation is different from line insertion.) If a parallel line is created, editing can be made easily.

 

◊ Select [Insert Row] from the [Edit] menu. A blank row is created under the instruction lint at the current cursor position.

2-3 Program Modification
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(6) Creating an OR circuit of coils
Here, the method of creating an OR circuit of coils is explained.

◊ Move the cursor to the circuit to be edited.
◊ Left-click the [Coil] button.
◊ Left-click the node at which a coil is to be connected.

Then an OR circuit of coils is created.

(7) Creating an OR circuit of data instructions
Move the cursor to the circuit to be edited.

◊ Left-click the [Data Instructions] button.
◊ Left-click the node at which data instructions are to be connected,
◊ Then an OR circuit of data instructions is created.

Here, the method of copying or cutting one or more line blocks and pasting them to some other place and the method of
deleting unnecessary line blocks are explained.

2-3 Program Modification
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(8) Deleting contacts and outputs
A contact and output can be deleted by selecting it with the mouse and then pressing the [DEL] key. However, the output at the
1st row of the line cannot be deleted.

Example: Deleting a contact or output in the following line

• Deleting contact B1
◊ Select B1 with the mouse.

◊ Press the [DEL] key.

• Deleting contact M0
In this case, the connecting line remains even if the [DEL] key is used. Therefore, use the  [Blank] and  [Clear vertical
connection] buttons instead of it.

◊ Left-click the  [Blank] button of the [Contact(N)] tab.
◊ Left-click the M0. M0 is deleted.

◊ Left-click the  [Clear vertical connection] button of the [Parallel(B)] tab.
◊ Left-click the B0. the vertical line is deleted.

2-3 Program Modification
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• Deleting output B11
◊ Select B11 with the mouse.

◊ Press the [DEL] key.

• Deleting output B10
Since the output at the 1st row cannot be deleted directly, delete the output at the 2nd row first and then change the address of
the output at the 1st row from B10 to B11.

◊ Select B11 with the mouse.

◊ Press the [DEL] key.

◊ Double-click B10 and change the address to B11.

(9) Merging lines
This function is used to merge two independent lines to make a single line. It is used to make vertical connection of two
independent lines.

◊ Position the cursor on a line to make vertical connection.

2-3 Program Modification
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◊ Select [Merge Line] from the [Edit] menu. The line at the current cursor position and the line just below it are merged to
form a single line.

◊ Left-click the [Parallel] tab of the [Instruction group] tab in the Ladder edit tool bar.
◊ Left-click the  [Vertical connection] button.
◊ Move the cursor to B1 (contact B) and then left-click it. A vertical connecting line is drawn.

(10) Dividing lines
This function performs an operation opposite to {Merging lines} in the previous section. Use this function after clearing a vertical
connecting line.

◊ Left-click the [Parallel] tab of the [Instruction group] tab of the Ladder edit tool bar.
◊ Left-click the  [Clear vertical connection] button.
◊ Move the cursor to B1 (B contact) and then left-click it. The vertical connecting line is cleared.

◊ Select [Divide Line] from the [Edit] menu. The line at the current cursor position and the line just below it are divided into
two lines.

2-3 Program Modification
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2-3-3  Changing tags
The following explains the procedure for changing a tag in the Ladder screen.

◊ Move the cursor to B0.
◊ Select [Modify Tag] from the [Edit] menu. The {Tag Editor} dialog box is displayed.

◊ Input <Switch 0> in the [Tag] text box.
◊ Left-click the [OK] button. The tag is changed.

About the {right-click} menu
A tag can also be changed by moving the cursor to B0, pressing the right mouse button to display the {Right click
menu} (see below), then selecting [Modify Tag].

2-3 Program Modification
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Here, the method of copying or cutting one or more line blocks and pasting them to some other place and the method of
deleting unnecessary line blocks are explained.

2-4-1 Selecting a line block
In order to copy, cut, or delete a line, it is necessary first to select a or groups of line.

(1) Selecting a single line block
◊ Move the cursor to the line to be selected.
◊ Left-click the mouse with the <Shift> key kept pressed.

An “S” (select) is displayed on the bus on the right and left of the line block selected.

* Releasing select status
To release the select status, move the cursor to the selected line block and left-click it.

Refer to “(1)
Selecting a single
line block.”

Refer to “(2)
Selecting two or
more line blocks.”

“S” indicates the line block
that has been selected.

2-4 Line Copy/Insert/Delete
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(2) Selecting two or more line blocks
◊ Move the cursor to the first one of the line blocks to be selected and left-click it.
◊ Using the scroll bar, let the last one of the line blocks to be selected be displayed. Then, left-click that line block with the

<Shift> key kept pushed.
(When the last line block to be selected is outside the program window, use the [Scroll] bar, [Arrow] buttons, <Page up>
and <Page down> keys to cause it to be displayed.)
“S” (select) is displayed on the buses on the right and left of the selected line blocks.

* Releasing select status
To release the select status, move the cursor to any one of the selected line blocks and left-click the line block.

(3) Selecting a line block with page specification
This function is used when selecting all the lines in a page with page specification.

◊ Select [Select Page] from the [Edit] menu.
The {Select Page} dialog box is displayed.

◊ Input a page number in the [Page number] text box and then left-click the [OK] button.

2-4 Line Copy/Insert/Delete
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2-4-2 Copying and pasting a line block
The method of copying a selected line block to the clipboard and pasting it to some other location is explained below.

(1) Copying a line block

◊ Select a line block to be copied.
(For the method of selecting a line block, refer to “2-4-1.”)

◊ Left-click the [Copy] button in the main window. (Alternatively, use the [Copy] command in the [Edit] menu or the
<Ctrl> + <C> keys.)
The selected line block is copied to the clipboard.

(2) Pasting the copy of line block
The method of pasting the copy of the line block to the position shown in the following diagram is explained.

◊ Move the cursor to the line containing contact address “B0005” (normally closed contact), and left-click the mouse.
◊ Left-click the [Paste] button in the main window. (Alternatively, use the [Paste] command in the [Edit] menu or the

<Ctrl> + <V> keys.)
As shown in the following diagram, the copy of the line block is inserted before the line block at the specified paste
location.

2-4 Line Copy/Insert/Delete
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2-4-3 Cutting and pasting line block (move)
Here, the method of cutting a selected line block, copying it to the clipboard, and pasting it to some other location is explained.

(1) Cutting a line block

◊ Select a line block to be cut.
(For the method of selecting a line block, refer to “2-4-1.”)

◊ Left-click the [Cut] button in the main window. (Alternatively, use the [Cut] command in the [Edit] menu or the <Ctrl>
+ <X> keys.)
The selected line block is copied to the clipboard, and the line block in the program window is deleted.

(2) Pasting the cut line block
The method of pasting the cut line block to the location shown in the following diagram is explained.

◊ Move the cursor to the line containing contact address “B0005” (normally closed contact) and left-click the line.
◊ Left-click the [Paste] button in the main window. (Alternatively, use the [Paste] command in the [Edit] menu or the

<Ctrl> + <V> keys.)
As shown in the following diagram, the cut line block is inserted before the line block at the specified paste location.

2-4 Line Copy/Insert/Delete
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2-4-4 Deleting a line block
Here, the method of deleting a selected line block is explained.

(1) Deleting a single line block

◊ Move the cursor to the line block to be deleted and left-click the line block.
◊ Left-click the [Delete Line] button on the [Edit Line] tool bar.

The selected line block is deleted.

(2) Deleting two or more line blocks at a time
For the method of deleting two or more line blocks at a time, refer to “2-4-3 Cutting line blocks.”

2-4 Line Copy/Insert/Delete

Delete this line block.
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There are two methods for preparing tags. One is using the {Tag Editor} dialog box that is displayed after the entry of an
instruction address during program editing. The other is using the {Tag Editor} window explained below.

2-5-1 Outline of Tag Editor
The {Tag Editor} is capable of directly editing address/tag data bases. This editor can be used only when the program window is
in the Edit mode.

<Getting the Tag Editor to be displayed>
◊ Left-click the [Tag Editor] button or select the [Edit Tag] command from the [Auxiliary Functions] menu in the main

window.
The {Tag Editor} window is displayed.

2-5 Tag Editor

{Tag Editor} window in initial state



2-54

2-5-2 Operation with Tag Editor
Here, the controls and fields on the tag Editor and the method of editing records (contents of records) are explained.

(1) Configuration of Tag Editor

1) Address field
“Addresses” of the PC memory are described in this field. Describe “addresses” within the PC memory capacity.

2) Tag field
“Tags” are described in this field. Each tag must be within 24 characters in length. The quotation marks (“ and ‘), comma (,), and
period (.) cannot be used in tag names. Any tag name must not consist entirely of numeric characters. It must not be the
associated address either. The same tag name cannot be set for different addresses.

3) Description field
“Descriptions” are described in this field. Each description must be within 50 characters in length. The comma (,) cannot be
used in descriptions. Any commas in a description are automatically deleted when the description is added to the data base.

4) Tag edit tool bar
[First record]  Moves the cursor to the first record in the data base.

[Prior record]  Moves the cursor to the prior record in the data base.

[Next record]  Moves the cursor to the next record in the data base.

[Last record]   Moves the cursor to the last record in the data base.

[Insert record]  Inserts a blank record right in front of the record at which the cursor is positioned.

[Delete record]  Deletes the record at which the cursor is positioned. Before the record is deleted, the {Confirm} dialog box
      is displayed.

[Edit record]   Sets the record at which the cursor is positioned in the Edit mode to enable the record to be edited.

2-5 Tag Editor
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[Post edit]   Registers the record that is being edited. The record is registered after it is confirmed that the record contains
      both an address and a tag, that the address format is valid, and that there is no tag duplication.

[Cancel edit]  Cancels the Edit mode and resets the record in the pre-edit state.

[Refresh data]  Refreshes the record displayed from the data base.

[Find] Searches for an address or a tag from database.

[Replace] Replaces a tag or explanation of database.

[Forward/Replace] Executes search and replace above and then perform Forward/Replace.

[Backward/Replace] Executes search and replace above and then perform Backward/Replace.

[Filter] Used to limit the tags to be displayed and edited using the address identifier.

5) Field name/operating bar
Displays field names. It also has the following functions.

<Changing field width>
To change the field width, move the cursor to any of the boundary lines between Address, Tag, and Description, and
shift it right or left with the left button of the mouse kept pushed.

<Changing order of display of fields>
Move the cursor into any of the frames of Address, Tag, and Description, and shift the frame right or left with the left
button of the mouse kept pushed.

(2) Inserting a new tag
◊ Left-click the [Insert record] button on the tag edit tool bar or push the <Insert> key. A blank record is inserted.

◊ Enter addresses, tags, and descriptions.
The <Tab> key can be used to shift from the address to the tag to the description. The entry of a description may be
omitted. However, be sure to enter an address and a tag before the record is registered in the data base. Each time a
new record is registered, the records in the data base are automatically sorted (rearranged) in order of address.

2-5 Tag Editor
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2-5-3 Importing tag text file
A text file (file extension: *.txt or *.csv) prepared by a word processor, data base application program, etc. can be imported as
tag data.

* CSV-format data
CSV (Comma Separated Value) refers to text data, each data item of which is separated by a comma (,).

(1) Text file format
For a text file to be input as tag data, it is necessary to describe each of its lines in the following format.

1) Text format

[Address],[Tag],[Description],[CR/LF]

• For [Address], describe a valid PC address (e.g., B0, B0010, M20, C15, etc.).
• For [Tag], describe a tag which does not exceed 24 characters in length.

If it exceeds 24 characters in length, only 24 characters are input from the first character. A duplicate tag name is
ignored.

• For [Description], the entry of a description may be omitted. When entered, the description must not exceed 50
characters in length.

• [CR/LF] refers to carriage return. Be sure to put a [CR/LF] at the end of each line.

A tag cannot be read on an address to which a tag has already been assigned.
Before loading a tag, delete the existing tag using a tag editor.

2) Example of description of text data

An example of display on the program when the above text data is input as tag data is given later in “(3) Display of tag after
input to file.”

2-5 Tag Editor
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(2) Importing text file
◊ Open the program (file) to which the text data is to be input.
◊ Select the [Import Tag File...] command of the [Documentation] from the [Auxiliary] menu.

The {Import Tags from text Files} dialog box is displayed.

◊ Select a drive and a folder to which the file is to be saved from the [Look in] list box.
◊ Select from or enter in the [File name] list box a text filename to be input.
◊ Left-click the [Open] button.

The text file (data) is input to the specified tag file.

(3) Display of tag after inporting text file
Tag imported from text file are immediately displayed in ladder display. (provided that “tag display” in editor setting in the
environment setting session is valid).
An example of display is given below.

2-5 Tag Editor
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It is possible to retrieve or replace an instruction address and a tag in the program that is being displayed in the program
window.

2-6-1 [Address/Tag] Find function

The method of retrieving an instruction address and a tag in the program being displayed in the program window is explained
below.

(1) First retrieval
◊ Get the appropriate program to be displayed in the program window.
◊ Left-click the [Find] button or select the [Find] command from the [Search] menu.

The {Find for Element} dialog box is displayed.

◊ Enter an address or a tag name in the [Address/Tag] text box and left-click the [Find] button to start the search
operation.
When the address (or tag name) is found, the associated line is displayed at the top of the screen. Since the dialog box
remains the same, press the [Find] button for the next search. If it is not found, the message “Serch item not found” is
displayed in the message box.
This find function searches for only a character string which completely coincides with the input character string.

<Explanation of the {Search} dialog box>

Direction:
Either “Forward” (search from the beginning of the scope of search toward the end) or “Backward” (search from the end
of the scope of search toward the beginning) can be selected.

Origin:
This option specifies the starting point of search. As the starting point, either “Cursor position” or “Beginning of selected
scope of search” can be specified.

Scope:
This option specifies the scope of search.

• Whole Program : This is the default, searching the entire program.
• Selected Lines : Only a previously selected line block is searched. For the method of selecting a particular line block,

refer to “2-4-1 Selecting a line block.”
• Page : Only a specified page is searched.  Enter a page number to be searched in the [Page Number] box.

Target:
This option specifies an instruction to be searched for.

• All Elements : All instructions are searched for.
• Contact Instructions : Only contact instructions are searched for (normally open contact and normally closed contact).
• Output Instructions : Only output instructions are searched for (normal Output/Set/Reset/Rising Differentiation Output/

Falling Differentiation Output/Step Control/Master Control/Timer/Counter instructions).
• Data Instructions : All instructions, other than the contact instructions and output instructions shown above, are

searched for.

2-6 Find/Replace Functions
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(2) Succeeding search
This item is used, after searching for an address or a tag name using the [Search] command explained in {(1) First search}, to
search for the same address or tag name.The search options that have been selected in the [Search] command remain valid.
The search operation is started from the last address or tag name that has been found.

◊ By selecting the [Search Next] command from the [Search] menu, it is possible to continue the search operation.

2-6-2 [Address/Tag] Replace function
The method of searching for an instruction address and a tag name in the program being displayed in the program window and
replacing them with any specified character strings is explained below.
The Replace function can be used only when the program window is in the Edit mode.

◊ Get the appropriate program to be displayed in the program window.
◊ Left-click the [Edit] button or select the [Edit Mode] command from the [Edit] menu. The program window enters the

Edit mode.
◊ Select the [Replace] command from the [Search] menu.

The {Replace} dialog box is displayed.

◊ Enter the address or tag to be replaced in the [Address/Tag] text box.
◊ Enter the new replacement address or tag in the [Replace with] text box.

Consecutive addresses can be specified as the Origin address for Replace, like "B10-B-2F."
Specify only the starting address as the Target address for Replace.

◊ Left-click the [OK] button to start the replace operation.
When the replace operation is completed, the {Information} dialog box is displayed and the number of replaced
addresses or tags is displayed.

<Explanation of the {Replace} dialog box>

Items related to search:
For the explanation of the search options (direction, scope, origin, target), refer to “2-6-1 [Address/Tag] Search function.”

2-6 Find/Replace Functions
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Replace option :
This item is effective only when the entire program is to be searched for.
When [With Tag/Description(G)] is selected, the tag is changed at the same time as the address. The tag name of the
address before replacement remains the same.
When [Delete Original(L)] is selected, the tag name of the address before replacement is deleted.

<Example of simultaneous tag change>
When replacing address WB0 with WB50, processing is performed as follows:

(Before replacement) (After replacement)

sserddA gaT sserddA gaT

0BW HC0golanA 0BW HC0golanA

05BW devreseR 05BW HC0golanA

sserddA gaT

0BW

05BW HC0golanA

Delete Original not selected

Delete Original selected

This tag is changed

Deleted

When [Bit Device in Word Device(I)] is selected, the bit addresses corresponding to the changed word address are
changed simultaneously.

Change NO/NC Contacts:
This option replaces all NO and NC contacts of specific addresses in the specified scope. When this option box is
checked, the [Replace] text box is hidden. Here, enter the address in the [Address/Tag] text box. All instructions of NO
and NC contacts are replaced.

Key-point

• Bit address Bit address 
• Word address Word address
• Tag Address 

        (bit/word)
• Address Tag 
    (bit/word)

• Bit address Word address
• Word address Bit address

X

X

Address replacement
All specific addresses in a specified scope are replaced with different addresses. Enter the address 
to be replaced in the [Address/Tag] text box, and enter the replacement address in the [Replace with] text 
box. A bit address can be only replaced with another bit address, and a word address can be only 
replaced with another word address. As the bit address/word address to be replaced, either an address 
or a tag may be entered. During the replace operation, the system checks whether or not the replacement 
address can be used for the instruction to be executed. If the replacement address cannot be used, 
the replace operation is not performed.

2-6 Find/Replace Functions
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2-6-3 Line Search function
This function searches for the program of any specified line number and displays it at the top of the screen.

◊ Select the [Go to Line Number...] command from the [Search] menu.
The {Go to Line Number} dialog box is displayed.

◊ Enter the line number to be searched for in the [Page.Line] text box.
◊ Left-click the [OK] button.

The specified line is displayed at the top of the screen.

2-6 Find/Replace Functions
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2-6-4 Instruction Search function
The following explains the procedure for searching for an instruction in the program currently displayed in the program window.

◊ Display the program to be searched for in the window.
◊ Select the [Instruction Search...] from the [Search] menu.

The {Instruction Search} dialog box is displayed.

◊ Select an instruction group with [Instruction List], select an instruction ([LMOV] in the example above), then left-click the
[Find] button to start search.
If the instruction is found, the line is displayed at the top of the screen. Since the dialog box remains the same, left-click
the [Find] button again to search for the following instruction.
If it is not found, the [Not Found] message box is displayed.

<Explanation of Search dialog box>
{Direction}, {Origin}, and {Scope} are the same as those in 2-6-1, “Address/tag search function.”

2-6 Find/Replace Functions
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System definition is unnecessary as long as the MICREX-F series is used as it is. It is necessary whenever the system is
expanded (with P/PE link, direct access, protection against system failure, etc.).

In this manual, the method of display of each of the dialog boxs for system definition and the method of operation in
each dialog box are explained.
For a detailed explanation of system definition, refer to the “User’s Manual <Instructions>.”

2-7-1 Display of dialog box in system definition

Here, the method of display of the dialog box for system definition is explained.
System definitions are registered in the program file. Therefore, it is necessary first to open the program (file) for system
definition.

◊ Open the program (file).
◊ Select the [Define System] command from the [PC Functions] menu.

The following four sub-commands are displayed.

◊ Select the appropriate sub-command.

2-7 System Definition

For the dialog box that is displayed
when each of the sub-commands is
selected, refer “2-7-2.”
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2-7-2 Operation in system definition dialog box
There are roughly four types of dialog box which are provided for system definition. Here, the method of operation in each of
those dialog box is explained, together with an example of display of each dialog box.

(1) System Registration dialog box
This is a dialog box for defining operations of the entire PC system, processor, and modules of the base board on which the
processor is mounted (direct access, etc.) the appropriate tab.

(2) T-Link Registration dialog box
This is a dialog box for defining operations of the individual devices that are connected to the T-Link.

◊ Left-click the appropriate items.

2-7 System Definition

Left-click the same tab as the channel
number of the T-Link interface (card) used.

Left-click the tab to define each item.
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2-7 System Definition

(3) P/PE-Link & ME-NET Registration dialog box
This is a dialog box for defining a P/PE-Link and ME-Net interface module (card).

(4) Message Module Registration dialog box
This is a dialog box for defining message communications.

Message module number

Specify the use of message module.
0: Not used, 1: Initial, 2: Transmission,
3: Reception

Set “1” when the T-Link is used in
the I/O expansion area.

Set the station number of the
counterpart of communications.

Set the data module number.

Specify the type of communication link.
0-3: T-Link, 4-5: P/PE-Link, 6: SUMINET,
7: W24
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Here, the method of saving a program which is being prepared and the method of opening a program which has been saved
are explained.

2-8-1 Saving a program
The method of saving a program which is being prepared (the content of the active program window) is explained below.

(1) Saving a program to a file
◊ Select the [File] menu.

The following commands are displayed.

◊ Select the [Save As...] command.
The {Save As} dialog box is displayed.

◊ Select a drive/folder to which the program is to be saved from the [Save in] list box or create a new folder.
◊ Enter the file name to which the program is to be saved in the [File name] text box.
◊ Left-click the [OK] button.

The program is saved as a new file.

2-8 Program Save/Open

Saves the program to a program file.
When the program that has been saved to a program
file once is modified and this command is executed,
the original program file is overwritten.

Saves the program as a new program file.
It is possible to rename the program and save it to a
file different from the drive/folder to which it has been
saved.
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(2) Contents of file during program save
When a program is saved in a file, the following contents are saved at the same time.

• To save in ladder file (.Ldx) format:

  <* .LDX file>
• Information about the PC model
• System definitions
• Ladder program

  <* .TAG file>
• Address/tag name and descriptive statement

  <* .CCT file>
• Line comment (text statement only; the instruction that points to the position of display of line comment is saved in “*

.LDX file.”

  <* .CFG file>
• Configuration file (print environment setting, etc.)

• To save in D25P loader file (.Pgs) format:

  <*.PGS file>
• To save in D25P loader file (.Pgs) format:Information about the PC model
• System definition
• Ladder program

  <*.CMM file>
• Comment files management file

  <*.C?? file>
• Comment files with the following identifiers

Identifier Description
.CMM Comment files management file
.CB1 Comment file with B identifier
.CM1 Comment file with M identifier
.CK1 Comment file with K identifier
.CT1 Comment file with T identifier
.CC1 Comment file with C identifier
.CD1 Comment file with D identifier
.CF1 Comment file with F identifier
.CA1 Comment file with A identifier
.CL1 Comment file with L identifier
.CS1 Comment file with S identifier
.CBW Comment file with WB identifier
.CMW Comment file with WM identifier
.CKW Comment file with WK identifier
.CFW Comment file with WF identifier
.CAW Comment file with WM identifier
.CLW Comment file with WL identifier
.CSW Comment file with WS identifier
.CST Comment file with TS identifier
.CRT Comment file with TR identifier
.CSC Comment file with CS identifier
.CRC Comment file with CR identifier
.CDB Comment file with BD identifier

2-8 Program Save/Open
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2-8-2 Opening a program file
The method of opening a program file which has been saved is explained below.

◊ Select the [File] menu.
The following commands are displayed.

◊ Select the [Open...] command.
The {Open Micrex-F Ladder Program} dialog box is displayed.

◊ Select the drive/folder to which the program file has been saved from the [Look in] list box.
◊ Select or enter the saved file name in the [File name] text box.
◊ Left-click the [Open] button.

The program file is displayed in the window.

2-8 Program Save/Open
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The following explains editing of the block diagram.

2-9-1  Edit area in block diagram

The edit area for a single line in the block diagram is shown below. Inputs, outputs, and instructions, etc. are assigned to this
area.

Connecting line assignment area

Input terminal assignment area Output terminal assignment area

8 blocks

Instruction and connecting line assignment area (5 blocks)

Input terminal assignment area: Only  [Block diagram input] can be assigned.

Output terminal assignment area: Only  [Block diagram output] and  [Output] can be assigned.

Connecting line assignment area: Only  [Vertical connection],  [Jump], and  [Path] can be assigned.

Instruction/connecting line assignment area: Instructions and connecting lines can be assigned.

2-9 Block Diagram Instruction
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2-9 Block Diagram Instruction

2-9-2  Example of editing of block diagram

The following explains the procedure for creating a block diagram using the following line as an example.
In this case, the tag input is omitted.

<Program description>
1) Data input from WB0 is limited to 100.
2) Data of 1) and data of BD0 are added.
3) SW of B10 is ON: The result of 2) is output to BD20 and used as an input of a comparison instruction.

SW of B10 is OFF: The contents of BD10 is output to BD20 and used as an input of a comparison instruction.
4) If the result of 3) is smaller than 500, B20 is turned ON; otherwise, B20 is turned OFF.

<Example of operation>
◊ Select [Insert Block Diagram] from the [Edit] menu.

The “Block Diagram Editor” window is displayed.

◊ Basically, input a program from the left to right, from the top downward.
Left-click  [Input block diagram] from the [Common] tab.

◊ Move the cursor to the upper left portion in the block diagram and then left-click it.
The {Address Entry Dialog} box is displayed.
Input <WB0> for {Address1} and then left-click the [OK] button.

Instruction buttons

Cursor

Block diagram editing area

Instruction group tabs
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2-9 Block Diagram Instruction

◊ As shown below, block diagram input {WB0} is displayed.

◊ Left-click the  [Upper limit] button of the [Analog] tab.
◊ Move the cursor to the right of {Block diagram input} and then left-click it.

The {Address Entry Dialog} box is displayed.
Input <100> in {Address1} and then left-click the [OK] button.

◊ As shown below, the  {Upper limit} instruction is connected.

◊ Left-click the  [Addition] button of the [Arithmetic] tab.
◊ Move the cursor to the right of the {Upper limit} instruction and then left-click it.

The {Address Entry Dialog} box is displayed. The address will be input later when connecting  {Block diagram input}.
In this case, left-click the [OK] button without inputting any data.

◊ As shown below, the  {Addition} instruction is connected.

◊ Left-click the  [Switch] button of the [Transfer] tab.
◊ Move the cursor to the right of the {Addition} instruction and then left-click it.

The {Address Entry Dialog} box is displayed.
Input <B10> in {Address1}, leave {Address 2} blank (it will be input later) and then left-click the [OK] button.
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2-9 Block Diagram Instruction

◊ As shown below, the  {Switch} instruction is connected.

◊ Left-click the  [Block diagram output] button of the [Common] tab.
◊ Move the cursor to the right of the {SW} instruction and then left-click it.

The {Address Entry Dialog} box is displayed.
Input <BD20> in {Address1} and then left-click the [OK] button.

◊ As shown below, the  {Block diagram output} is connected.

◊ Connect the {Block diagram input} for the {Addition} instruction.
Left-click the  [Block diagram input] button.

◊ Move the cursor below the {Addition} instruction and then left-click it.
The {Address Entry Dialog} box is displayed.
Input <BD0> in {Address1} and then left-click the [OK] button.

◊ As shown below,  {Block diagram input} is connected to the {Addition} instruction.

◊ Extend the vertical connecting line of {SW}.
Left-click the  [Vertical connection] button.

Cursor
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2-9 Block Diagram Instruction

◊ Move the cursor below the {SW} instruction.
A vertical connecting line is connected.

◊ Connect {Block diagram input} to the vertical connecting line.
Left-click the  [Block diagram input] button.

◊ Move the cursor below the vertical connecting line and then left-click it.
The {Address Entry Dialog} box is displayed.
Input <BD10> in {Address1} and then left-click the [OK] button.

◊ As shown below,  {Block diagram input} is connected to the vertical connecting line.

Cursor
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2-9 Block Diagram Instruction

◊ Place the {Comparison} instruction.
Left-click the  [Comparison result is smaller] button of the [Comparison(I)] tab.

◊ Move the cursor to the bottom right portion of the {SW} instruction.
The {Address Entry Dialog} box is displayed.
Input <500> in {Address1} and then left-click the [OK] button.

◊ The {Comparison} instruction is displayed as shown below.

◊ Connect the output of the {SW} instruction and the input of the {Comparison} instruction.
Left-click the  [Vertical connection] button of the [Common(C)] tab.

◊ Move the cursor to the {Vertical connection assignment area} to the right of the {SW} instruction. A vertical connecting
line is connected.

◊ Left-click the  [Vertical connection] button again.
◊ Move the cursor below the vertical connecting line and then left-click it.

As shown below, a vertical connecting line and the input of the {SW} instruction are connected.

Cursor

Cursor
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2-9 Block Diagram Instruction

◊ Left-click the  [Output] button.
◊ Move the cursor to the right of the {Comparison} instruction and then left-click it.

The {Address Entry Dialog} box is displayed.
Input <B20> in {Address1} and then left-click the [OK] button.

◊ As shown below, {Output} is connected to the output of the {Comparison} instruction.

◊ Left-click the [Save] button. The {Block Diagram Editor} window closes.
The block diagram created is inserted into the Ladder edit screen.

If the [Save] button is left-clicked before completing creation of a line, an error results. In this case, the edit screen
cannot be closed.

Cursor

Cursor
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2-9 Block Diagram Instruction

2-9-3  Notes on editing block diagram

(1) Instructions that can be connected to each terminal
Instructions are categorized into the following three types according to the number of I/O terminals and the type of output.

1) 1 input (WORD), 1 output (WORD) type ... INV, LMOV instructions, etc.
2) 2 inputs (WORD), 1 output (WORD) type ... Addition, subtraction, a maximum, AND instructions, etc.
3) 2 inputs (WORD), 1 output (output) type ... Comparison, TBIT instructions, etc.

Example of 1) Example of 2) Example of 3)

Input A Output C Input A Output C Input A Output C

Input B Input B

• For {Input A}, only  [Block diagram input] or a connecting line can be connected.
• For {Input B},  [Block diagram input] and a connecting line can be connected and an address or constant can be

input.
• For {Output C},  [Block diagram output] or a connecting line can be connected for cases 1) and 2), and only 

[Output] can be connected for case 3).

(2) Deleting instructions, connecting lines, etc.
To delete, move the cursor to the cell (frame) and then press the [DEL] key.

(3) Inserting instructions, connecting lines, etc.
There is no insertion function. Overwrite is possible.

(4) Arranging block diagram input (output)
For block diagram input (output), a connecting line is automatically connected to input (output) terminal assignment area. It is
not necessary to use  [Path] to connect connecting lines. When it is placed under a 2 input type instruction, it is vertically
connected to an instruction input.

When  [Block diagram input] is placed in cell 1)

1 2

3
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2-9 Block Diagram Instruction

When  [Block diagram output] is placed in cell 2)

When  [Block diagram input] is placed in cell 3)

(5) Right-angled connection of block diagram (right-angled connection of a vertical line and a horizontal line)

In the line below, follow the steps below to make right-angled connection of the output of  [Addition] and the input of 
[Multiplication].

◊ Left-click the  [Vertical connection] button of the [Common] tab.
◊ Move the cursor to the {Vertical connection assignment area} between  [Addition] and  [Subtraction] and the left-

click it. A vertical connecting line is connected.

◊ Left-click the  [Vertical connection] button again.
◊ Move the cursor below the vertical connecting line and then left-click it.

As shown below, the vertical connecting line and the input of the  [Multiplication] instruction is connected in the right
angle.

Cursor
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2-9 Block Diagram Instruction

Follow the steps below to write the [Multiplication] instruction later.

◊ Left-click the  [Vertical connection] button of the [Common] tab.
◊ Move the cursor to the {Vertical connection assignment area} between  [Addition] and  [Subtraction]. A vertical

connecting line is connected.

◊ Left-click the  [Vertical connection] button.
◊ Move the cursor below the vertical connecting line and then left-click it. A vertical connecting line is connected.

◊ Left-click the  [Multiplication] button of the [Arithmetic operation] tab.
◊ Move the cursor under the  [Subtraction] instruction and then left-click it. When the {Address Entry Dialog} box is

displayed, input an address and then left-click the [OK] button.

◊ Left-click the  [Vertical connection] button of the [Common] tab.
◊ Move the cursor to the vertical connecting line to the right of the  [Multiplication] instruction and then left-click it. The

vertical connecting line changes to right-angled connection.

Cursor

Cursor
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2-9 Block Diagram Instruction

2-9-4  Limitations on block diagram

1) A line consisting of 9 rows or more cannot be created.

9 rows

Error

2) For the leftmost symbol, a line in which an input signal flows from the top downward cannot be created.

From the top downward

OK
Solution

Input signal direction in a block diagram is from 
the left to right and from the bottom upward.

3) A line in which a signal flows from the right to left cannot be created.

From the right to left

Solution A
A

Signal direction is 
from the left to right.

4) A line in which outputs are ORed cannot be created.
This is a logical error which must not be done.

Solution

Cursor
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